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サウンド・サンプル  

  

 

 

この度はSpark DUBSTEPをお買い上げ頂きましてありがとうございます。 
 

本パッケージには以下のものが同梱されています。： 

Spark DUBSTEP インストーラー DVD-ROM ：Mac OS X 、Windows XP/ Vista / 7 

レジストレーションカード（クレジットカードサイズのもの）：シリアルナンバーとアンロックコードが記されています

。 

 Spark DUBSTEP ソフトウェア・クイックガイド 

 

カードは大切に保存してください。 

本ソフトウェアを使用するためには、製品登録を行わなければなりません。登録することによって、あなたは自

分が正当な所有者であることを認識し、本製品の最新ニュースとアップデート情報を得ることが可能になります

。  

Spark DUB Stepのオーソライズには、シリアルナンバーと、アンロックコードを登録する必要がありますので、こ
れらのコードは大変重要です。  

詳細なオーソライズ手順については、第 1章をご確認ください。: 

 

 

スペシャル・メッセージ  

 

仕様変更について：  
本マニュアルに含まれる情報は、印刷した時点で正しいと思われるものです。しかし、Arturiaは仕様更新に伴う
内容の変更、修正等を事前の告知なく行う場合があります。 
 
重要：  
本機は、ヘッドフォンとスピーカーの両方、またはどちらか一方を使用して、聴覚障害を起こすほどの大音量に

設定出来る場合があります。そのような大音量や不快に感じるほどの音量で長時間本機を操作、演奏しないで

ください。 
難聴、もしくは耳鳴りなどを自覚した場合には、直ちに専門家の診断を受けてください。 
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注意：  
知識の不足による、誤った操作から発生する問題に対してのサポートは、保証の対象外となり、料金が発生し

ます。まずこのマニュアルを熟読し、販売店とご相談の上、サポートを要求することをお勧めします。 
 
 
CD-ROMの取扱いについて：  

ディスクの光る面（データが収録されている面）に触れたり、傷つけないよう注意して下さい。傷ついたり、汚れ

たりした CD-ROMは正しく読み込めなくなる場合があります。CD-ROMは綺麗な状態で保つために、市販のク
リーナーなどを使用して下さい。 

. 
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1  はじめに  

1.1  SPARK DUBSTEP について 

Spark DUBSTEP は、480のインストゥルメントと 30キットとハードヒット、ドラムや破壊的なフィルタリングモジュ
レーション・サウンドを 960パターン収録しています。 

Spark DUBSTEPはサンプル・ライブラリーではありません。Spark DUBSTEP は、サンプルの使用だけではなく、
カスタム・プログラムされたバーチャル・アナログシンセ、ドラム、エフェクトを使用できます。 

多くの人々を踊らせるサウンドを作るために完璧なリズムトラック・コンストラクション・キットです。 

使いやすく、オートメーションさせる機能が含まれ、サウンドやライブパフォーマンス機能が充実し、エディットす

ることもきるという多くの要望を叶えられるマシンは Spark DUBSTEP だと言えるでしょう。 

1.2   ARTURIA の歴史 

2001年初頭、アートリアはアナログ回路のオーディオ解析をデジタル・エミュレーション技術で再現する先進的
なアルゴリズム開発に着手しました。それは、技術的な言語を使用しなくても、かつて一世を風靡したモーグ・モ

ジュラー型のようなシンセサイザーのユニークで無二なサウンドを再現できる前代未聞のものでした。そのアル

ゴリズムに着手してしばらく後、アートリアはその成果を世に問う準備を始めました。2002年にカリフォルニアで
開催された NAMMショーにて、アートリアは後にボブ･モーグ博士からも絶賛をあびた「モーグ・モジュラー V」
として商品化されるソフトウェア・シンセサイザーのプロトタイプを発表しました。 

音楽制作において常に本物のサウンドを追求しているエキスパートたちは、自分の納得できるサウンドにはとて

も貪欲です。モーグ博士自らがお墨付きを与えた「モーグ・モジュラー V」は彼らから大絶賛をあび、発売と同時
に大成功をおさめ、様々な音楽誌にて賞を総なめし、ビンテージ・シンセサイザーの再現に関して先駆者的存

在となったのです。 

2004 年までの間に、アートリアには著名なミュージシャン、プロデューサー、バンドの方々から多くの電子メール
が届きました。彼らの多くは自分が所有しているハードウエア・シンセサイザーをバーチャル（ソフトウェア）・シン

セサイザーに置き換えることを計画していました。世界中のアーティスト連中がハードウェアよりもソフトウェアの

アドバンテージに注目し始めたのです。 

CS-80Vは、2003年にニューヨークで開催されたAESショーにて発表されました。 それは“究極のポリフォニック・
シンセサイザー”として一斉を風靡したヤマハのCS-80 を完全に再現したものでした。キース・エマーソン、スティ
ービー・ワンダーなどの憧れの著名音楽家が愛用した本物が、無限の可能性と共に「CS-80V」として蘇ったの
です。 

「アープ 2600V」は 2005年の NAMMショーにて発表されました。ドラムンベースや映画スターウォーズの R2-
D2の音などで有名なアープ 2600 を忠実に再現したのです。 さらに斬新なトラッキング・ジェネレーターやステッ
プ･シーケンサーとの合体など、アートリアらしい商品の仕上げ方にミュージシャン、音楽業界より絶賛を浴びま

した。 

2006年の NAMMショーにてアートリアは 7番目の商品として「プロフェット V」を発表しました。世界一有名な
アナログ・ポリフォニック・シンセサイザーとして君臨したプロフェット 5 と、ユニークなベクター合成方式とウェー
ブテーブル式デジタル・シンセサイザーの草分け的存在であったプロフェット VS という 2台のシンセサイザーを
合体させた強力なハイブリッド・ソフトシンセのアイデアは瞬く間に業界のエポックメイキングなトピックスとなりま

した。 

2007年夏の NAMMショーにて、アートリアは「ジュピター８ Ｖ」を発表しました。音色の可能性において、この
製品はこれまでと異なる何かをアートリアのラインナップにもたらしました。「ジュピターJP８Ｖ」は実に多彩な音



ARTURIA – SPARK DUBSTEP – QUICK START 9 

作りの可能性を持っています。いわゆる「ファット」な音や「透明感」のある音を容易に創造出来ます。 まさに洗
練され、スマートなその外観通りに。 

オリジナルの「ジュピター８」のクオリティはエレクトロ-ポップミュージック・シーンはすぐ浸透しました。フランキ
ー・ゴーズ。トゥ・ハリウッドの「リラックス」はこれを使用して制作されました。ヴィンス・クラーク、ジョン・フォック

スおよびマーティン・ウェアーらもこの楽器を使いました。ここがジュピター８を確立するステータスの出発地点で

した。ジュピター８は以下のミュージシャン達が使用しました。 

ハワード・ジョーンズ、タンジェリン・ドリーム、アンダーワールド、ジャン・ミッシェル・ジャール、ディペッシュ・モー

ド、プリンス、ゲイリー・ライト、エイドリアン・リー、ヘヴン・セヴンティーン、喜多郎、エルビス・コステロ、ティアー

ズ・フォー・フィアーズ、ヒューイ・ルイス＆ザ・ニュース、ジャーニー、モーグ・クックブック、イエス、ディーヴォ、フ

レディ・フレッシュ、シンプル・マインズ、ヤン・ハマーetc. 

2011年に Arturia は、SPARK Creative Drum Machineを発売しました。このパワフルなハイブリッド・インストゥ
ルメントは、プロデューサーや、ライブ・ビートメーカーをターゲットとしていました。それは 16 ステップのプログラ
ミングとライブアプローチパッドやフィルター、スライサー、ループ機能をミックスしたユニークなワークフローを提

案します。クラシック・アナログドラムのエミュレーションだけでなくArturiaのバーチャル・アナログに関する専門
知識を活かし、アコースティック・ドラム、物理モデル、パワフルなエレクトリック・ドラムキットが 1 つの使いやす
いインターフェイスに集約しました。Sparkは、Sandy Vee, the Glitch Mob, the Mars Volta, Vitalic, DJ Quick, 
Yeasayer等の素早くトップ・プロデューサーやアーティストに広く愛用されるようになりました。 

 

. 
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2 クイックスタート  

この章では SPARK ソフトウェアのユーザーインターフェースについて紹介します。特定のユーザーインターフェ
ースの名称について調べる必要がある場合、この章に戻って確認することができます。 

SPARKのユーザーインターフェースは「トップ」、「センター」と「ボトム」という 3つのメインパネルに分けられて
います。 

2.1.1 センターパネル 

SPARK を立ち上げるとデフォルトではセンターパネルが表示されます。  

 

1. デジタルディスプレー 
2. シーケンサーゾーン 
3. ソング/パターンゾーン 
4. ジョグダイヤル 
5. FX ライブパッド 
6. インストゥルメントコントロールゾーン 
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2.1.2 ボトムパネル 

ボトムパネルはスタジオ、ミキサー、ライブラリーの調整を行います。 

 

1. スタジオ・ボタン 

2. インストゥルメントのディスプレイ 1 ～ 8 

3. インストゥルメントのディスプレイ 9 ～ 16 

4. すべてのインストゥルメントの表示 

5. ミキサーボタン 

6. ライブラリーボタン 
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2.1.3 トップパネル 

トップパネルは、パターン、ソングとライブラリーインターフェースを有しています。 

 

1. パターンボタン 

2. ソングボタン 

3. プリファレンス 

2.2  各部の名称と機能について 

この章では、SPARKで使用する用語やその機能について紹介します。 

2.2.1 プロジェクト（Project） 

プロジェクトは、ソングで使用する全てのデータを意味します。：設定を含む 16 インストゥルメントキットと最大 64
パターン、オートメーション、FX 

2.2.2 キット（Kit） 

各キットは、16 個のインストゥルメントから成り立ちます。（バスドラム、ハイハット等）プロジェクトウインドウ下の
ライブラリーで全てのインストゥルメントキットを観ることができます。（パネル下部）  

2.2.3 インストゥルメント（Instrument） 

インストゥルメントは、トラックパッドに割り当てられたオーディオ・ソースから発生する音です。例えばメインパネ

ルで左下のパッドを叩くトラックにはバスドラムを割り当てることができます。 
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2.2.4 オーディオ・ソース（Audio Source） 

サンプル (.wav, .aiff オーディオ・ファイル) 
物理モデル (フィジカル・パラメーター) 
アナログ (アナログ・パラメーター付きビンテージ・ドラムマシン) 

2.2.5 バンク（Bank） 

SPARK にはA、B、C,Dと呼ばれるバンク 4つにそれぞれ 16 パターンを作成可能です。メインパネルのソング/
パターン・ゾーンで、“A”と“1”をクリックしてください。 

その後、プレー/ポーズ・ボタンをクリックすると、バンクAのパターン 1 を再生します。 

2.2.6 パターン（Pattern） 

パターンは、インストゥルメントで演奏される音のシーケンスです。   

2.2.7 ソング（Song） 

ソングは曲の構造を決めるいくつかのパターンを編集することができるシーケンスです。SPARK のソングは最
大 64のパターンを使用して作成可能です。 

2.2.8 チャンネル（Channel）  

特定のチャンネルはミキサーの各インストゥルメントに割り当てられています。チャンネルは、インストゥルメント

と同じように 1から 16までにナンバリングされています。  

2.2.9 トラック（Track） 

トップパネルのパターンウインドウは 16のインストゥルメント・トラックを備えています。各トラックは 1 つのインス
トゥルメントをプレーすることができます。  

2.3  オーディオと MIDI のセットアップ 

2.3.1 Windows  の場合 

プリファレンス・ウインドウにアクセスするために SPARK メニュー＞セットアップ＞オーディオ＆MIDI設定をクリ
ックしてください。このウインドウは SPARKのグローバル・プリファレンスを設定することができます。これらは
自動的に保存されます。   

2.3.2 Mac OS X の場合 

プリファレンス・ウインドウにアクセスするために SPARK メニュー＞プリファレンスをクリックしてください。オーデ
ィオセッティングが現れます。このウインドウは 
オーディオ＆MIDIセットアップの詳細については本マニュアルの第 6章を参照してください。 
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2.4  SPARK のファーストステップ 

ヘルプモードは、すべてのコントローラーのショートカットを表示するために使用することができます。

すべてのショートカットを表示するように Spark のインターフェイスを変更するには、左上隅にある
をクリックしてください。“SELECT ”を押しながらボタンを押すとブルーになっている任意のテキストの
二次的な機能を選択します。 

 

2.4.1 プロジェクトのロード 

プロジェクトをロードするためにツールバーをクリックして「LOAD」を選択してください。  
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「ファクトリープロジェクト」の上にカーソルを動かしてドロップダウンリストを使用してプロジェクト（例：Funk）をク
リックしてください。  
選択したプロジェクトは SPARK にロードされ、その名前は「SAVE」ボタンの隣にあるウインドウに表示されます。 

2.4.2 パターンの選択とプレー 

パターンを選択してプレーするには、カーソルを「ソング／パターン」ゾーンに動かし、パターンのバンクを選択し

ます。例えば「BANK A(Aをクリック)」を選択しバンクA のパターン 1（1 をクリック）します。そうすると選択したボ
タンがハイライトされ、選択したことを知らせます。  

 

次にトランスポート・ゾーンの「Play/Pause」ボタンをクリックして選択したバンク A のパターン 1 を再生しましょ
う。他のパターンを聞くために他のパターンナンバーをクリックしてみてください。パターンを変更するために毎

回 SPARK を止める必要はありません。バンクを切り替えても同じように動作します。. 

2.4.3 インストゥルメントパラメーターの変更 

各インストゥルメントのパッド上にある 3 つのボタン（ツマミ）はインストゥルメントのパラメーターです。まず、スネ
アドラムのピッチを変えてみましょう。パターンを再生中にカーソルをスネアのパッド上にある「Pitch」ボタンを持
って行き、クリックし、ホールドしたままゆっくりとカーソルを動かしてみてください。こうすることによってピッチノ

ブを動かし「音程（Pitch）」を上下に動かすことができます。動かした後に、スネアドラムのピッチがどのように変
化しているか聞いてください。デジタルディスプレーの中央にあるメインパネルには変更したピッチレンジを表示

します。  

 

2.4.4 インストゥルメントの選択、フィルターの変更と、ミキサーのパラメーター 

インストゥルメントを選択（例：スネア）するためには、カーソルを左から二番目のパッドの上に動かしてください。

そうするとセレクションゾーンに入ったことがわかるようにインストゥルメントの右側にある境界線がハイライトさ

れます。 
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クリックをすると、「スネア」パッドは選択されたことを伝えるように赤く点灯します。またはセレクト・ボタンとイン

ストゥルメント・パッドを押しても選択することが可能です。 
セレクトモードを解除するにはもう一度セレクト・ボタンをクリックしてください。 

 

 
フィルターやミキサー・パラメーターを変更するためには、まずインストゥルメントを選択し、そしてフィルターやミ

キサーパラメーターボタンのどれかをクリックし、押さえたままパラメーターを変更するためにツマミを左右に動

かすか、マウスで上下にドラッグしてください。メインパネルのデジタルディスプレイウインドウは、リアルタイム

に選択されたパラメーターの変化を表示します。  

 

2.4.5 パターンのプレーとエディット 

パターンを再生するためにセンターパネルインターフェース左上の「プレー/ポーズ」ボタンを使用してください。 

 

パターンを編集するには、メインパネル上部にある 16個の小さいパッドを使用します。パターンを再生するとプ
レーするポジションの小さいパッドがリアルタイムに光ります。パッドが光っているときは、シーケンサーがその

位置で MIDI ノートをプレーすることを意味します。逆に消灯している場合は何も再生しません。パッドを押すこ
とによって音をトリガーする/しないを決定します。 
より詳しく見ていきましょう。バンク A、パターン 1 をクリックし、スネアドラムトラックを選択してください。：メイン
パネル上部の 16 個のスモールパッドを見てください。いくつかのパッドが点灯しています。これは点灯している
部分がノートオンで消灯している部分はノートオフです。   

 

点灯している全てのパッドの位置でスネアが発音されます。パッドを押して点灯、消灯をさせることによってトラ

ックをエディットすることができます。 
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パターンを再生しながらボタン「2，3，4，5」をクリックしてください。そうするとボタンは消灯し、スネアの音は聞こ
えなく（発音しなく）なります。次にパッドの「1，4」をクリックしてください。そうするとすでにオリジナルのパターン
をプログラムし始めていることになります。簡単ですね。 

2.4.6 インストゥルメント・パッドを使用したパターンのレコーディング 

何もない最初の状態からパターンを作るには、まず現在のパターンを消去します。最初に「Erase」ボタンをクリッ
クし、次にソング/パターン・ゾーンでパターンナンバーを選択するとパターは消去されます。今回はバンク Aの
パターン 1 を使用します。 

 

16 個のパッドがすべて消灯していることを確認して下さい。（スネアドラムトラックが空になったため）ソング/パ
ターン・ゾーンを見るとすべてのパッドが消灯していることがわかります。パターン 1 をクリックしてください。これ
でインストゥルメント・パッドを使用して新しいパターンを作成する準備が整いました。 
メトロノームを使用するためにメトロノームボタンをクリックし、ボリュームを適度な音量に調節してパターンレコ

ーディングを始めてください。メトロノームボタンをもう一度クリックするとメトロノームのスイッチをオフにできます。  
 
センターパネル下部の左側のパッドで「Bass Drum」をクリックしてください。これでバスドラムを演奏することにな
ります。レコーディングボタンを押した後にプレーボタンを押すとバスドラムのレコーディングをはじめます。 

 

パッドでバスドラムをプログラムして一度、「ストップ」をクリックしてください。「プレー」をクリックするとレコーディ

ングしたパターンを再生して確認できます。他のインストゥルメントをレコーディングするために他のインストゥル

メント・トラックを選択して同手順を繰り返してください。（インストゥルメントの選択については、4.5.4「インストゥル
メントの選択」を参照してください）  

2.4.7 ジョグダイヤルを使用したインストゥルメント/キットの変更  

ジョグダイヤルを使用してインストゥルメントを変更するにはまず変更したいインストゥルメントを選択してください。

ソング/パターン・ゾーンのジョグダイヤルを使用してインストゥルメントの上でクリックしてください。ジョグダイヤ
ルをクリックしたままでマウスを上下に動かすと新しいインストゥルメントを選択することができます。インストゥル

メント名は、メインパネル中央のデジタルディスプレーに表示されます。新しいインストゥルメントを選択したらも

う一度ジョグダイヤルをクリックすると新しいインストゥルメントがロードされます。 
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特定のインストゥルメントだけでなくキットを変更する場合も手順は同じです。：ジョグダイヤルの下部にある

「KIT」をクリックし、あとは同じ手順を行って下さい。 

インストゥルメント・モードで使用するジョグダイヤルは、インストゥルメント・タイプとジェネレーターのタイプを選

択するメニューも含まれています。 

 

2.4.8 プロジェクトの保存 

プロジェクトを保存するにはツールバーの「Save」をクリックします。ドロップダウンメニューが現れるので「Save 
As」を選択します。 

 

プロジェクトに名前を付け、ドロップダウンメニューから音楽スタイルを選択して「OK」をクリックしてください。こ
れで無事にプロジェクトが保存されました！このプロジェクトはディスプレイ・ウィンドウに表示されます。次回か

らは「Save」ボタンをクリックすれば OKです。 

2.4.9 アドバンス・セッティング 

SPARK DUBSTEPのインターフェイスは「トップ」パネル、「センター」パネル、「ボトム」パネルの 3 つのメインパ
ネルから成り立っています。  

「トップ」パネルを表示するためにツールバーの「TOP」をクリックしてください。これでトップパネルへのアクセス
が可能になります。  

- アドバンス・パターン・エディットを行うためのパターン・パネル：パターンの分解能、レングス、拍子、オートメー

ションのエディット 
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- アドバンス・ソング・エディットを行うためのソング・パネル 

- Spark DUBSTEP のプリファレンスをカスタマイズするプリファレンス・パネル 

 

「ボトム」パネルを表示するためにツールバーの「BOTTOM」をクリックしてください。これでボトムパネルへのア
クセスが可能になります。  

- アドバンス・インストゥルメント・エディットを行うためのスタジオ・パネル：インストゥルメントのロード、フィルター・

パラメーターとインストゥルメント・タイプ、名前、パラメーターのエディット 

- ミキサー・パネル：インストゥルメントのパン、ボリューム、インサートの設定、AUXとメインエフェクトのエディット 

- ライブラリー・パネルの  

o プロジェクトの高度な編集：画像、タイプ、ロード・インストゥルメントの編集 

o ライブラリーをブラウズ 

o ライブラリーからのインポートとエクスポート 

 

アドバンス・セッティングの詳細については弊社ウェブサイト上より“Spark Creative Drum Machine” の完全なマ
ニュアルを参照してください。 

ウェブサイト： http://www.arturia.com/manuals.html 
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3 オペレーションのモードについて  

3.1  スタンドアローン 

Spark DUBSTEP は、独立したインストゥルメント（スタンドアローン）として使用することが可能です。 

これは、単一の楽器のようにアプリケーションを起動し、外部 MIDI キーボードを使用して操作する
ことができます。 

3.1.1 アプリケーションの起動 

Spark DUBSTEP アプリケーションを起動するには、 

• Windows では、スタート > すべてのプログラム > Arturia > Spark DUBSTEP > Spark 
DUBSTEP を選択 

• Macintoshでは、ファインダー > アプリケーション > Arturia フォルダ内の Spark DUBSTEP 
アイコンをダブルクリック 

3.1.2 インストゥルメントの設定 

Windows：アプリケーション・メニューバーの“設定”をクリック 

Macintosh：“環境設定”をクリックすると、次の AUDIO＆MIDI 設定ダイアログボックスを表示しま
す。 
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このオプション・メニューでは以下の内容を設定します。 

• オーディオ出力ポートの設定 

• オーディオインターフェイスの選択 

• メモリー・バッファーサイズの選択（少ないサイズは CPU 負荷を増しますが、レイテンシーを
減少させます） 

• サンプル・レートの選択：44100 Hz ～ 96000 Hz 

• MIDI 入力ポートの選択 

• Spark シーケンサーをコントロールする MIDI クロックの選択 

• Spark Sequencer から MIDI クロックを送信するときの MIDI オフセット・サンプルを設定しま
す。 

3.2  VST 2  

VST (Virtual Studio Technology) とは、Steinberg 社によって開発されプラグイン・フォーマットです。
これは DAW やホスト・ソフトウェアとソフトウェア・シンセサイザーやエフェクト・プラグインを統合し

て使用することができます。 VST は、Cubase、Nuendo、Wavelab、FL Studio、Audacity、
Samplitude、Sonar、Audition、Live 等多くのオーディオ・アプリケーションによってサポートされてい
ます。 

VST インターフェイスは 1999年にバージョン 2 へアップデートされました。追加された機能の一つ
は、プラグインに MIDI データを送受信できるようになったことです。これは VST インストゥルメント
形式のプラグインの導入を可能としました。 

3.3  VST 3 

VST3 は VST オーディオ・プラグイン・プロトコルの新しいアップデートです。2008 年に導入され、
以前のバージョンに比べて改善された性能を持っており、同様に新しい機能を数多く備えています。

Cubase 6 と Nuendo 5 はこのプロトコルを採用しています。 

Windows 上で VST 3 を使用するとユーザーは、インストールするフォルダのパスを選択する必要
がありません。インストーラーは、ハードディスク上の適切なディレクトリに自動的に VST 3 ファイル
をインストールします。 

3.4  RTAS 

RTAS とは、Real-Time AudioSuiteの略で、Pro Tools システムで使用するために digidesign（Avid 
Technology）によって開発されたオーディオ・プラグインです 

3.5  AU 
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AU とは Audio Units の略で、Apple Computer が開発したプラグイン・プロトコルです。GarageBand、
Soundtrack Pro、Logic Express、Logic Audio、Final Cut Pro、Mainstage、Ardour、Ableton Live、
REAPER、Digital Performer等で使用することができます。 

3.6  64 ビット・コンパチビリティ 

Spark DUBSTEP は 32 ビットと 64 ビット両方のモードに最適化されています。64 ビット・オペレーティング・シ
ステムと 64 ビットのデジタル・オーディオ・ワークステーションを使用している場合は 64 ビットのプラグインを
使用する必要があります。（windowsの場合）  

通常、32 ビットの windows 上ですべての 32 ビット・プログラムは、“C:\Program Files”にインストールされま
す。ただし 64 ビット・Windows 上では、64 ビット・プログラムは、“C:\Program Files\”で、32 ビット・プログラム
は、“C:\Program Files (x86)\”にインストールされます。 

Mac ユーザーは、一つのプラグイン・ファイルに 32 ビットと 64 ビットの両方のバージョンが含まれており、ホ
ストが自動的にマッチしたバージョンを選択するので、Mac ユーザーはこれを気にする必要はありません。 

 

3.7  プラグイン・モード 

VST、Audio Unit と RTASの使用に関する詳細な情報については、セクション 0、 0、0 を参照してください。 

 

コントローラーをプラグイン・モードで正しく動作させるためにシーケンサーソフトでいくつかのMIDI接続をオフに
擦る必要があります。シーケンサーのMIDIセッティングに行き、「Spark Private In」と「Spark Private Out」をオフ
にします。  

以下のセッティング以外： 

- Spark controller will not connect to Spark on Windows.  

- Spark controller will not behave correctly on OSX. 

 

SPARK をステレオ、またはマルチアウトプット・モードとして使用可能です。ステレオ・モードで使用する場合、一
組のステレオ出力を提供します。マルチアウトプット・モードでは、１６組のステレオアウトプットを使用可能です。

ミキサー・パネルで SPARK のトラックのアウトプットルーティングを変更可能です。デフォルトルーティングでは、
１番のアウトプットにマスターステレオアウトプットを送ります。全部で 16 個のステレオ出力を別々に割り当てる
ことが可能です。詳細についてはセクション 5.3.2.1 を参照してください。 

3.7.1 ツールバーのエクストラ・ボタン 

 

SPARKをプラグイン・モードで使用する時に、ツールバーには 2つのボタンが追加されます。 
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1.  ホストボタン  
「On」になっていると Sparkのパターンのスタート/ストップは、ホストシーケンサーと同期します。 

2.  テンポボタン  
「On」になっていると Sparkのテンポはホストのテンポと同期します。 

3.7.2 プロジェクトの保存 

プロジェクトを保存する際、SPARKのすべての変更点が完全な状態で保存されます。 
例えば、パラメーターを変更し（プラグイン自体にプリセットとして保存することなく）作業を行い、プロジェクトを保

存した場合、次回プロジェクトを開いたとき SPARKは変更した状態をロードします。 
 

VST シーケンサーのドロップダウンメニューは新しいプロジェクトを保存することができ、SPARK にも使用でき
ますが、SPARK 内部のメニューでの保存を強く推奨します。SPARK 内部に保存した場合、スタンドアローン時
でも、他のシーケンサー上でも使用可能ですし、将来、SPARK がバージョンアップした際にも互換性を持ちます。 

3.7.3 ホストアプリに SPARKシーケンサーとパッドからの MIDIアウトのレコーディングする 

SPARKソフトウエアシーケンサーから、またはパッドからのMIDIアウトやパターンチェンジをホストにレコーディ
ングすることが可能です。SPARKのパターンから出力されるすべての音をレコーディングし、オートメーション化
することができます。この昨日はAUとVSTにおいてのみ可能で、RTASでは現在使用不可能です。 

どのMIDIデータを送信するか選択するために“プリファレンス”を使用してください。： 

“Send Midi From Pads ”を選択するとSPARKのパッドからMIDIデータやパターンチェンジ情報をホストへ送信し
ます。 

“Send Midi From Sequencer ”を選択するとSPARKシーケンサーからホストへとMIDIデータを送信します。 

 

 

3.8  CUBASE/NUENDO (VST)で使用する 

3.8.1  VST インストゥルメントとして使用する 

“Spark DUBSTEP” を VSTプラグインとして使用する場合、他の VSTプラグインと同じ方法でご使用になれま
す。詳細はホストアプリケーションのユーザーマニュアルを参照してください。Cubaseや Nuendoでご使用にな
る場合、« デバイス / VST インストゥルメント » メニューを開いてラックの中から“Spark DUBSTEP”を選択して下
さい。 
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3.8.2 Cubase でプラグイン・ディレクトリの再スキャン 

Spark DUBSTEP が VST プラグインのリストに表示されない場合、プラグイン・ディレクトリの
“rescan”を行うことができます。 

3.8.3 プリセットの保存 

セッションを保存すると、プリセットを変更した音色であっても「SPARK」で操作した情報は保存されます。
「SPARK」のプロジェクトをエディットしパラメーターを変更したセッションを保存し、次回同じセッションを開くと
「SPARK」自体に保存していなくても修正後の状態で起動します。 

しかし、特に必要がない場合は「SPARK」自身に保存することをお奨めします：この方法で保存されたプリセット
は他のモード（スタンドアローン、他のシーケンサー）でも使用でき、独立したファイルとしてエクスポートすること

ができます。これらは「SPARK」の今後のバージョンでも互換性を持ちます。 
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3.8.4 マルチアウトプット・モード 

VSTインストゥルメントメニューで「SPARKを立ち上げます。そしてこのメニューのインストゥルメント名の左側の
ボタンをクリックすることによって出力先を選択することが可能です。 

 

3.8.5 RSPARKから VSTホストへの MIDIアウトを使用してレコーディング  

LIVEを使用してSPARKからMIDIアウトからVSTホストへレコーディングする際の設定の例です。： 

- LIVEのトラック上にSPARK VSTプラグインを立ち上げてください。 

- SPARKからMIDIのレコーディングを行うためにMIDIトラックを作成してください。 

- 追加したMIDIトラックの設定を行います。（画像の左側のトラック）：:  

・ ‘Midi From’ を‘Spark’にし、 ‘Pre FX’を ‘Spark’に変更してください。  

・モニターを ‘Auto’に設定してください。 

・セッションレコーディングを作動状態にしてください。 

- SPARKトラックの設定を行います。（画像の右側）  

・ ‘Midi From’を新しいＭＩＤＩトラックに合わせてください。 

・モニターを ‘Auto’に設定してください。 
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LIVEのレコードボタンを押してください。SPARKソフトウェアのホストとテンポボタンがオンであることを確認して
ください。LIVEの（Tabを押して）アレンジメントビューを表示し、いくつかのMIDIノートをレコーディングしたことを
確認してください。 

 

 

SPARKトラックのモニターを“in”に設定してください。 

SPARKのホストボタンをオフにします。（LIVEのプレーボタンを押してもSPARKシーケンサーはプレーしなくなり
ます） 

プレーボタンを押すと、LIVEのアレンジメントを再生します。以前、SPARKからレコーディングしたデータを現在
はLIVEから送信しているMIDIデータをSPARKで再生しているのでSPARKの音をモニターしてください。 

 

注：CUBASEユーザー様へ：SPARKをMIDIソースとして選択するために“Menu > Devices > VST Instrumentを”
を使用してSPARKをロードしてください。VSTインストゥルメント・トラックを作成するとMIDIソースとしてSPARK
を表示しません。 

 

3.9   PRO TOOLS (RTAS)で使用する 

3.9.1 プラグインとして使用する 

Spark DUBSTE をプラグインとして起動するには、他のプラグイン同様インストゥルメント・トラックを作成してく
ださい。 
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Spark DUBSTEP は、ステレオのインストゥルメント・トラックにインサートする必要があります。起動した後は、
バーチャル・キーボードをマウスでプレーすることや外部コントローラーから操作しながらサウンドを作ること

ができます。 
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3.9.2 プリセットの保存 

セッションを保存すると、プリセットを変更した音色であっても「SPARK」で操作した情報は保存されます。
「SPARK」のプロジェクトをエディットしパラメーターを変更したセッションを保存し、次回同じセッションを開くと
「SPARK」自体に保存していなくても修正後の状態で起動します。 

ProToolsの「Librarian Menu」のソング保存機能を使用してソングを保存することで音色等の設定を保存するこ
とも可能です。しかし、特に必要がない場合は「SPARK」自身に保存することをお奨めします：この方法で保存さ
れたプリセットは他のモード（スタンドアローン、他のシーケンサー）でも使用でき、独立したファイルとしてエクス

ポートすることができます。これらは「SPARK」の今後のバージョンでも互換性を持ちます。 
 

3.9.3 Pro Tools上でのオートメーション 

「SPARK」へのオートメーション操作は他の RTAS/HTDM プラグインと同様です。 
（プラグインのオートメーション機能の詳細については、ProToolsのマニュアルをご参照ください) 
 

3.10   LOGIC で使用する (AU) 

 Logic Pro 7以降には AUマネージャーが搭載されています。AUマネージャーを起動するには“Logic Pro”
メニューから“Preferences -> Start Logic AU Manager”の順に選択してください。 

新しいソフトウェアインストゥルメント・トラックを作成します。  

 

選択したトラックと同じミキサーのスライス上で、プラグインリストを表示するために「I/O」ボタンをクリックしてくだ
さい。そして AU Instruments > Arturia > Spark DUBSTEP > Stereo を選択してください。 
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3.10.1.1 マルチアウトプット・モード 

インストゥルメントごとに別々のアウトプットを使用したい場合にこの機能を使います。  

インストゥルメント・トラックを選択してください。選択したトラックと同じミキサーのスライス上で、プラグインリスト

を表示するために「I/O」ボタンをクリックしてください。そしてAU Instruments > Arturia > SPARK > Multi Output 
(16xStereo)を選択してください。  

 

そしてミキサービューへいき、AUX トラックを追加するためにインストゥルメント・トラックの下部にある「+」ボタン
をクリックしてください。 
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ミキサービューで各インストゥルメントの出力先を選択できます。（詳細についてはセクション 5.3.2.1 を参照して
ください） 

3.10.2   SPARK からＡＵホストへの MIDI アウトを使用してレコーディング 

より高い精度でご使用いただくために 2つのオプションを並行してご使用いただくことをお勧めしません。： 

第一にパッドからMIDIをレコーディングする“Send Midi From Pads to Host ”をオンにし“Send Midi From 
Sequencer to Host ”をオフにします。その後、レコーディングし終わったら“Send Midi From Pads to Host ”をオフ
にし、“Send Midi From Pads to Host ”をオンにします。 

 

- AUホストにMIDIデータを送信する際に使用するIACドライバーを設定するために  ‘Audio Midi Setup 
Application’を起動します。MIDIスタジオビューでIACドライバーのアイコンをダブルクリックしてください。 

 

- ‘Device is online’ をチェックしてください。 

- ポート名を ‘Spark1 MIDI OUT’に変更してください。 

 
-  Logicを起動してください。 

- インストゥルメント・トラックを作成し、SPARKAUプラグインを立ち上げてください。 

- SPARKソフトウェアのホスト、テンポボタンをオンにします 

- Window > Environmentを開いてください。 

- 左上部の‘Click & Ports’を選択して下さい。 

- 物理的なインプットボックスでは、シーケンサーの入力に“SPARK1 MIDI OUT”からの接続を設定してください
。 

 

- SPARKのトラックを選択して下さい。 

- SPARKのトラックの‘Record’はオフ にしてください。 

- レコードを押しLogicにレコーディングしてください。 
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-SPARKソフトウェアのホスト、ボタンをオフにしてください。 

 

3.11   ABLETON LIVE で使用する (AU AND VST) 

プラグイン・タブで Spark DUBSTEP のアイコンをダブルクリック VSTまたは AU アイコンをダブル
クリックするか、プラグインを MIDI トラックへドラッグ＆ドロップしてください。 

  

必要な場合には、プリファレンスのファイル・フォルダ・タブからプラグインのディレクトリの再スキャン

を行うことができます。 

“Sacn”ボタンを押すか、フルスキャンを行うために[Alt]キーを押しながら“Scan”ボタンを押してくださ
い。 

 

3.11.1  Digital Performer で使用する 

3.11.1.1  ステレオ・モード 

インストゥルメントを追加するためにはメニューの Project > Add Track > Instrument Track > Arturia > Spark 
(stereo)を選択してください。 
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インストゥルメントを立ち上げた後にMIDIトラックを割り当てるのはとても簡単です。MIDIトラックのコネクション
メニューで使用するインストゥルメントとMIDIチャンネルを選択するだけです。プレー、またはレコーディングを行
う前にトラックを起動してください。 

3.11.1.2  マルチアウトプット・モード 

別々の出力を使用するには、必要な分のオーディオ・トラックを作成し、Spark プラグインの出力を正しく接続し
てください。 

 

3.11.1.3  MIDI トラックのアサイン 

インストゥルメントを立ち上げた後にMIDIトラックを割り当てるのはとても簡単です。MIDIトラックのコネクション
メニューで使用するインストゥルメントとMIDIチャンネルを選択するだけです。プレー、またはレコーディングを行
う前にトラックを起動してください。 

3.11.2  ステレオ・モードとマルチアウトプット・モード 

3.11.2.1  ステレオ・モード 

インストゥルメントを追加するためにはメニューの Project > Add Track > Instrument Track > Arturia > Spark を選
択してください。 
インストゥルメントを立ち上げた後に MIDI トラックを割り当てるのはとても簡単です。MIDI トラックのコネクショ
ンメニューで使用するインストゥルメントと MIDI チャンネルを選択するだけです。プレー、またはレコーディング
を行う前にトラックを起動してください。 
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3.11.2.2  マルチアウトプット・モード 

インストゥルメント・トラックを選択してください。選択したトラックと同じミキサーのスライス上で、プラグインリスト

を表示するために「I/O」ボタンをクリックしてください。そして AU Instruments > Arturia > SPARK > Multi Output 
(16xStereo)を選択してください。  
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SPARK DUBSTEP に関する法律情報  

3.12  ソフトウェア・ライセンス契約 

 

1使用許諾  
アートリア社はお客様に対し、非独占的な権利として単一のコンピューターで“アナログ･ファクトリー”のプログラ
ム（以下“ソフトウエア”という）を使用する権利を与えます。また、アートリア社は許諾者に非明示的に付与した
権利のすべてを留保します。 
 
2所有権  
お客様はソフトウェアが記録またはインストールされた媒体の所有権を有します。アートリア社はディスクに記録

されたソフトウェアならびに複製に伴って存在するいかなるメディア及び形式で記録されるソフトウェアのすべて

の所有権を有します。この許諾契約ではオリジナルのソフトウェアそのものを販売するものではありません。 
 
3著作権  
ソフトウェア及びマニュアル、パッケージなどの付随物には著作権があります。ソフトウェアの改ざん、統合、合

併などを含む不正な複製と、付随物の複製は堅く禁じます。このような不法複製がもたらす著作権侵害等のす

べての責任は、お客様が負うものとします。 
 
4使用の制限  
お客様は、常に 1 台のコンピューターで使用することを前提として、一時的に別のコンピューターにインストール
して使用することができます。お客様はネットワークシステムなどを介した複数のコンピューターに、ソフトウェア

をコピーすることはできません。お客様は、ソフトウェアおよびそれに付随する物を複製して再配布、販売等をお

こなうことはできません。お客様はソフトウェアもしくはそれに付随する記載物等をもとに、改ざん、修正、リバー

ス・エンジニアリング、逆アセンブル、逆コンパイル、翻訳などをおこなうことはできません。 
 
5譲渡の制限  
お客様はソフトウェアを譲渡、レンタル、リース、転売、サブライセンス、貸与などの行為を、アートリア社への書

面による許諾無しにおこなうことは出来ません。また、譲渡等によってソフトウェアを取得した場合も、この契約

の条件と権限に従うことになります。 
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限定保証と免責  
限定保証アートリア社は通常の使用下において、購入日より 30 日間、ソフトウェアが記録されたディスクに瑕
疵がないことを保証します。購入日については、領収書の日付をもって購入日の証明といたします。ソフトウェ

アのすべての黙示保証についても、購入日より 30日間に制限されます。黙示の保証の存続期間に関する制限
が認められない地域においては、上記の制限事項が適用されない場合があります。アートリア社は、すべての

プログラムおよび付随物が述べる内容について、いかなる場合も保証しません。プログラムの性能、品質によ

るすべての危険性はお客様のみが負担します。プログラムに瑕疵があると判明した場合、お客様が、すべての

サービス、修理または修正に要する全費用を負担します。 
 
賠償  
アートリア社が提供する補償はアートリア社の選択により（a）購入代金の返金（b）ディスクの交換のいずれかに
なります。お客様がこの補償を受けるためには、アートリア社にソフトウェア購入時の領収書をそえて商品を返

却するものとします。この補償はソフトウェアの悪用、改ざん、誤用または事故に起因する場合には無効となり

ます。交換されたソフトウェアの補償期間は、最初のソフトウェアの補償期間か 30 日間のどちらか長いほうに
なります。 
 
その他の保証の免責  
上記の保証はその他すべての保証に代わるもので、黙示の保証および商品性、特定の目的についての適合

性を含み、これに限られません。アートリア社または販売代理店等の代表者またはスタッフによる、口頭もしくは

書面による情報または助言の一切は、あらたな保証を行なったり、保証の範囲を広げるものではありません。 
 
付随する損害補償の制限  
アートリア社は、この商品の使用または使用不可に起因する直接的および間接的な損害（仕事の中断、損失、

その他の商業的損害なども含む）について、アートリア社が当該損害を示唆していた場合においても、一切の

責任を負いません。地域により、黙示保証期間の限定、間接的または付随的損害に対する責任の排除につい

て認めていない場合があり、上記の限定保証が適用されない場合があります。本限定保証は、お客様に特別

な法的権利を付与するものですが、地域によりその他の権利も行使することができます。 

 


